
Organize and Prepare 

Photos for Processing

Photoshop Elements 8 is the latest version of 
this excellent program for working with 
photographs on the computer. Photoshop 
Elements may be Photoshop’s smaller sibling, 
but it is no second-rate program. Photoshop 
Elements uses the same processing engine that 
Photoshop uses to make your work with photos 
efficient and effective — but it is simpler and 
directly geared to photographers. And for the 
first time in many versions, the latest Mac and 
Windows versions of Photoshop Elements are 
the same. Everything in this book works the 
same with either platform except for occasional 
keyboard commands. 

Photoshop Elements is a complete program 
that enables you to import images, organize 
them, and sort the good from the bad as well 
as make changes to optimize individual photos. 

The order of this book follows a workflow that 
you can use to work efficiently in Photoshop 
Elements.

In this chapter, you learn what it means to 
develop a workflow right from the start. You 
can quickly import, sort, and organize your 
pictures so that you can find them more easily 
in the future. You can customize your 
workspace to fit your needs and interests and 
help you work more efficiently. You can also set 
preferences so that your program works its 
best. Do not skip over these seemingly 
mundane tasks because they can really help 
you speed up your work. Once you have 
practiced and learned the core controls of the 
program, you will find that you can work very 
quickly with Photoshop Elements.
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● Set the tonalities of your photos 
first, including blacks, whites, and 
midtones, and then adjust color.

● Start the process by getting your 
photos into Photoshop Elements 
in order to sort, keep, delete, and 
organize them. You can process 
individual photos without going 
into the Elements Organizer 
module of the program, but the 
Elements Organizer helps you 
manage your digital photos.

Workflow has become a real buzzword for 
photographers working with their images on the 
computer, but it simply describes the process of how 
you work with images from start to finish. It is 
important that you develop a consistent way of 
working on your images that will give you reliable 
results.

This book is structured in such a way to show you a 
Photoshop Elements workflow that really does work. 

Although you can skip around in the book to find 
specific tips, the book is ordered to follow this 
workflow. As you become familiar with the program, 
you might find that you have to adapt some of these 
ideas to your specific needs. Do that as long as you 
are getting the results you expect from your images.

Develop a

WORKFLOW
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● Consider how you want to share 
your photos with others, 
including prints, photo books, 
Web galleries, e-mail, and much 
more.

● Fix problems in your 
photos such as wrong 
colors, defects in an 
image, sensor dust, and 
so on.

Did You Know?
Photoshop Elements was originally 
designed to make Photoshop more 
accessible for photographers. 
Photoshop was first developed to 
help people work on photos on the 
computer, not for photographers. 
Photoshop Elements has always had 
the photographer as the primary 
focus of its development and 
enhancement.

Try This!
Make your image immediately fill 
the central work area by pressing 
Ctrl/Cmd+0 (if you press Ctrl/
Cmd+O, you get an Open dialog 
box). You can do this when a 
photo first comes into the 
program edit space or when you 
have enlarged a portion of the 
photo and need to go back to 
seeing all of it.

Did You Know?
Editing photos used to mean 
picking the good from the bad. 
When Photoshop was developed, 
the computer folks decided to call 
the changes to the images editing, 
so there is confusion about what 
editing really is for the 
photographer. This book avoids 
both usages and specifically 
describes the process being used.
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 The Photo Downloader dialog 
box appears.

4 Click here to select your camera 
or card reader.

5 Click Browse to select where you 
want the photos to go on your 
hard drive.

Importing from a Digital Camera or 

Memory Card

1 Click File.

2 Click Get Photos and Videos.

3 Click From Camera or Card 
Reader.

In order to work on your images, you must get them 
onto your computer and recognized by Photoshop 
Elements. To use the Organizer in Photoshop 
Elements, you have to tell the program how to deal 
with your photos. It needs, in a sense, a map to 
where your photos are located. Photoshop Elements 
can help you import your photos from memory card 
to hard drive, including copying them from the card 
into a specific folder and renaming the files, as well 
as having Organizer recognize them. Or you can tell 

Photoshop Elements to recognize photographs that 
are already on your computer.

When you first open Photoshop Elements, click the 
Organizer button to go into the Organizer mode. All 
importing is done through this mode. Once the 
Organizer recognizes the images, they appear as 
thumbnails on your screen, which you can then sort, 
place into albums, and generally place them in an 
order that makes them easy to locate.

IMPORT
your images
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9 Click here to select or create 
subfolders in the new folder, such 
as ones based on dates photos 
were shot, or choose None.

0 Click here to rename your photos 
or keep the original file names.

! Type a new name for your photos 
if needed. 

@ Click here to leave photos on the 
memory card so that your camera 
can reformat the card properly.

# Click Get Photos.

 The photos will now be imported 
into your computer and included 
in the Organizer.

$ When the Files Successfully 
Copied dialog box opens, 
click yes. 

 Navigate to the folder 
you want to use in the 
directory tree that 
appears.

6 Click Make New Folder 
for a new group of 
photos.

7 Name your new folder.

8 Click OK.

Did You Know?
A quality memory card 
reader is the fastest and 
most dependable way to 
download images. A card 
reader needs no power, 
can be left connected to 
your computer, and will 
not be damaged if 
accidentally knocked to 
the floor.

Did You Know?
The Automatic Download check box in 
the Photo Downloader dialog box sets 
up your computer to automatically 
download photos based on criteria set 
in Preferences, found in the Edit menu 
for PCs and the Photoshop Elements 
menu for Macs. This can be a problem 
because it does not enable you to put 
photos into specific folders for each 
download, nor does it enable you to 
rename photos.

Did You Know?
Most photographers prefer to put images 
into distinct file folders on their hard drives 
instead of lumping them together into the 
Pictures folder. Photo Downloader enables 
you set up specific folders based on date 
and location. For example, you can put 
photos in a folder called Digital Photos on 
your hard drive to make them easier to 
find if the Organizer in Photoshop 
Elements ever fails.
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 The advanced Photo Downloader 
dialog box appears.

3 Click Check All to import all 
photos.

4 Click UnCheck All to deselect all 
photos to select specific images 
for import.

5 Click the first photo of your 
group to import.

Advanced Importing from a Digital 

Camera or Memory Card

1 Repeat steps 1 to 4 from the 
“Importing from a Digital Camera 
or Memory Card” section to 
open the Photo Downloader 
dialog box.

2 Click Advanced Dialog.

Sometimes you will have groups of photos on your 
memory card that you do not want to mix together 
into a single folder. It can be very helpful to keep 
your photos separated by folders so that you can 
always find images on your hard drive, even without 
Photoshop Elements. The program gives you the 
option to import only the pictures that you want from 
a memory card in an advanced dialog box. This dialog 

box is very similar to the Photo Downloader dialog 
box, but it includes some additional choices you 
should know about.

Photoshop Elements also enables you to import 
images already on your hard drive. The process is 
very similar, but does use a different dialog box. This 
can be useful when you have transferred pictures 
directly from one computer to another, for example.

IMPORT
your images
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Did You Know?
When the Organizer recognizes 
photos, Photoshop Elements does 
not move or change them unless 
you tell it to. Photoshop Elements 
is simply creating a map to these 
image files on your hard drive so 
that it can find and organize the 
photos as needed.

Try This!
Use the Light Bulb icons ( ). 
Photoshop Elements scatters tips 
throughout the program to help 
you when you do not understand 
a particular control or option. 
Click the icon and a tip appears, 
providing information on how to 
use the control or option.

Did You Know?
Having your name and copyright 
information on a photo helps 
people keep track of your photos. 
Even if you are not a pro, having 
your name in the metadata means 
that if you give your photo files 
to someone, such as for an 
organization’s brochure, everyone 
will know whose photos they are.

9 Click here to open Advanced 
Options if it is not already open.

● A good option to select is Import 
into Album (  changes to ) if 
you have albums set up.

0 Click here to open Apply 
Metadata if it is not already open.

! Click here to select Basic 
Metadata.

@ Type your name for the Creator 
and Copyright text boxes.

# Click Get Photos.

 The photos will now be imported 
to your computer and included in 
the Organizer.

6 Scroll down to the 
last photo in the 
group.

7 Shift+click that last 
photo to select all 
photos from the first 
one to this one, but 
no others.

 Press Ctrl/Cmd+click 
isolated photos to 
add or remove them 
from the group.

8 Click the check box 
under any image to 
check all that are 
selected. 
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  A full-screen image appears.

● The playback toolbar also appears 
at the bottom of the screen.

3 Click the arrows to move the 
display of photos forward or 
backward from the whole group 
in Organizer.

1 Click a photo that you wish to 
see Full Screen.

2 Click the Full-Screen icon, the 
little monitor with a playback 
arrow.

The Organizer in Photoshop Elements is great for 
seeing a whole lot of photos at once. This can help 
you check out your latest photo shoot as well as 
visually find important images. But seeing larger 
images enables you to find the best photos, whether 
it means checking sharpness, focus, a person’s 
expression, and so on. 

While you have always been able to look at larger 
versions of your photo in previous versions of the 

software, Photoshop Elements 8 now includes a 
full-featured full-screen mode. This mode removes all 
distractions from your monitor so you can focus just 
on your image. This truly makes the image the star 
and puts the software in the background. This can 
make it easier to evaluate your photos after importing 
them because you can easily move from one photo to 
the next. 

VIEW PHOTOS
with full-screen mode
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 A filmstrip appears.

● The active photo is highlighted in 
blue in the filmstrip and also 
appears enlarged in the main 
work area.

6 Click any image in the filmstrip to 
display it large. 

7 Press the Escape key to go back 
to Organizer. 

 A new photo appears.

4 Move your cursor to the 
left side to open the 
Quick Organize panel. 

 Use the Quick Organize 
panel for quickly adding 
keywords or putting a 
photo into an album.

5 Click the filmstrip icon 
on the bottom toolbar.

Did You Know?
The full-screen view can be used as a 
slide show. Click the center arrow of the 
bottom toolbar to start playing images or 
pause the slide show. You can change 
how long each image is on the screen as 
well as play music with the photos by 
clicking the Wrench icon, which gives you 
settings to try. You can only play this slide 
show when the Photoshop Elements 
program is open. 

Try This!
The full-screen playback can be very 
helpful, but sometimes you want to 
go back and forth between the 
Organizer multi-image view and the 
full-screen view. You can do this 
quickly and easily with the function 
key F11. Press F11 to go from 
Organizer to Full Screen, and then 
press the Escape key to go back to 
Organizer. 

Did You Know?
The Quick Edit panel in the 
full-screen view can be a 
useful way to quickly make 
adjustments to your photos. 
Move your cursor over the 
Quick Edit bar to expand the 
panel. Then choose controls 
that will enable you to 
adjust your photo. 
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4 Select the Details check box to 
show ratings (  changes to ).

Note: You can also click the View 
menu and then View Details to 
show ratings.

5 Click the stars to rate your 
photos.

 You can use a system such as one 
star for those photos you reject, 
five stars for the best ones, and 
various numbers of stars in 
between to define which photos 
you like or dislike.

Set Up Your View of the Photos 

1 Click and drag the thumbnail 
slider to change the sizes of your 
photo thumbnails.

2 Press Ctrl/Cmd+click photos to 
select images that you want to 
rotate.

3 Click the appropriate Rotate icon 
to rotate the selected photos.

Traditionally, going through your pictures, finding the 
good ones and getting rid of the bad has been called 
photo editing. However, when computer engineers 
developed programs like Photoshop, they decided to 
call changing pictures in those programs photo editing 
too, so the term can be confusing. Still, you do need 
to go through your pictures and edit them based on 
the original definition of the word.

Photoshop Elements gives you some excellent tools to 
do just that. You can compare pictures, look at 
pictures in different sizes, and discover which pictures 
work well for you and which do not. To save hard 
drive space and eliminate clutter there, you should 
delete images that really do not satisfy you, thus 
reducing the number of pictures you have to go 
through to find the really good ones.

SORT
the good pictures from the bad
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 The Confirm Deletion from 
Catalog dialog box appears.

0 Select the Also delete selected 
item(s) from the hard disk check 
box to throw out your rejects 
(  changes to ).

 Make sure the Also delete 
selected item(s) from the hard 
disk check box is deselected 
to only remove photos from 
Photoshop Elements view 
(  changes to ).

● If you feel that you made a 
mistake, you can click Cancel and 
change the ratings.

! Click OK to finish the process.

@ Click Show All to get your photos 
on screen again.

Delete Photos You Do Not 

Want

6 Click one rating star in 
the upper right of the 
thumbnail display.

7 To limit photos to only 
those with one star, 
click the box to the 
right of the stars and 
select only.

8 Select all photos with 
Ctrl+A.

9 Press Delete.

Remember!
You can delete images from Photoshop 
Elements and/or off your computer 
altogether. Simply select the image you 
want to remove and press Delete. This 
opens a dialog box that enables you to 
decide if you simply want to remove 
the photo from Photoshop Elements’ 
view or remove it from the hard drive 
completely.

Try This!
To see any image at a large size, 
double-click it. This shows you the 
photo filling the thumbnail area 
without any other photos. This helps 
you better see details in your photos, 
such as sharpness or exposure 
problems. Double-click the image 
again to go back to the thumbnail 
view.

Did You Know?
You can show file names 
and other detail using the 
View menu. Click View and 
then select the appropriate 
menu item to show these 
details in your thumbnail 
display.
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3 Click Edit.

 The Edit menu opens.

4 Select Stack.

5 Select Stack Selected Photos.

1 Click the first image of a group 
that could be stacked.

2 Shift+click the last image of that 
group.

 The whole group is now selected.

Most people who enjoy digital photography take 
advantage of the fact that once you own the camera 
and memory card, there is no cost for taking pictures. 
This means you can freely photograph a subject, 
trying different angles or varied techniques. However, 
as you do this, you accumulate a lot of similar photos 
in your digital files. That can make working with a 
particular group of photos more challenging because 
you have to look at a lot of similar images before you 
come to the new ones. 

Stacking is a new Photoshop Elements 8 feature. It 
enables you to place special subgroups of your photos 
into stacks that then display as if they were one 
image. This can simplify the view of your photos in 
Organizer. You can also use stacks to keep a 
particular small group of photos together. 

STACK 
your images
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 The stack opens and is 
highlighted as a group.

7 Click the small arrow at the 
middle of the right side of the last 
photo to collapse the stack again.

  The images are visually 
stacked so you see only 
one.

● The Stack icon appears 
in the upper-right 
corner of the stack to 
inform you it is a stack. 

6 Click the small arrow at 
the middle of the right 
side of the photo 
thumbnail.

Compare!
Many times you will find that two 
photos look similar and you simply 
want to find and keep the best. You do 
not necessarily want or need a stack. 
Photoshop Elements has a great tool 
that enables you to compare photos 
two at a time. Select two photos, and 
then click the Display button at the top 
right of the interface and select Compare 
Photos Side by Side. The two photos 
will now be displayed full screen next to 
each other.

Try This!
You can also use stacking to 
simplify and organize your 
thumbnail view. For example, 
you could stack photos of each 
child at a birthday party so that 
the entire group of party photos 
is organized into stacks based on 
individuals. Pressing Ctrl/Cmd+
click isolates photos to select 
them.

Did You Know?
Stacking is simply another way 
to group photos so they are 
useful to you. It is based on an 
old technique slide shooters 
used when sorting photos. They 
would pile similar slides on top 
of each other, making stacks 
that kept their light tables better 
organized. 
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3 You can group albums by using 
the Album Group function, but 
start with None (Top Level).

4 Type a name for your album.

5 Deselect the Backup/Synchronize 
check box until you have a 
Photoshop.com account 
(  changes to ).

● Your selected photos appear in 
the Content box.

1 Ctrl+click photos to select 
individual images, or click a 
photo and then Shift+click the 
last image in a group to select 
photos in order.

 You can also press Ctrl/Cmd+A to 
select all photos.

2 Click the large green plus sign 
under Albums and select New 
Album to add an album.

● You can open the Albums section 
of the task panel by clicking the 
arrow next to the word Albums.

Albums are groupings of pictures based on your 
needs. You can create albums based on events such 
as birthdays, locations such as a recently visited city, 
family members, and much more.

Albums enable you to quickly find pictures even if 
they are part of a very large collection of images. 
They also enable you to group pictures together even 
if they were not taken at the same time. For example, 
you could set up an album based on a child’s name 

and then put images of that child into that album. If 
you did this over time, you would have a collection of 
images of that child from many different times and 
places.

Albums do not duplicate photographs. They only 
create references to where the pictures are on your 
hard drive. For that reason, individual pictures could 
be in many albums, which can help you find them 
faster in different ways.

CREATE ALBUMS
to group your pictures
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Did You Know?
You can add photos to an album at 
any time. Whenever you see a 
photo that belongs in an album, 
click it and then drag it to the 
album. It is automatically placed in 
the album and will appear there 
whenever that album is opened. 
Remember you are only creating 
references to photos and not 
actually moving any.

Try This!
You can immediately put any new 
photos just imported into 
Photoshop Elements into an 
album. Select all images in that 
new group of photos, add an 
album with a name appropriate to 
that group, and the photos should 
appear in the Contents box. If not, 
select and drag the new pictures 
into that Item box.

Smart Albums!
You can create a smart album that 
automatically adds photos to the 
album. You set up criteria, such as 
file names, keywords, and camera 
type, in the New Smart Album 
dialog box, which you access by 
clicking the Albums plus sign ( ). 
Whenever a photo with those 
criteria appears in Photoshop 
Elements, it is automatically 
included in the smart album.

 The new album now appears in 
the Albums panel.

8 Click the album to select it.

● The photos you put in the album 
now appear with a small icon 
below them to indicate they are 
in albums.

9 To see that icon, select Details 
(  changes to ).

● You can edit your album by 
clicking the Edit icon.

6 Click an image and drag 
it into the Content box 
to add it to an album.

Note: Neither adding nor 
deleting photos from an 
album affects their 
position on the hard 
drive.

7 Click Done.
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 A drop-down menu appears.

● You can choose New 
Sub-Category or New Category 
to create your own category for 
keywords.

4 Select New Keyword Tag to add 
a keyword.

1 Click the arrow in front of 
Keyword Tags to open the 
keyword part of the Organize 
task panel.

● For more space, close Albums by 
clicking the arrow by that title. 

2 You can start with the keywords 
that are listed.

3 Click the large green plus sign 
under Keyword Tags.

Keywords are words that you add to your photo’s 
metadata (information about the image held in the 
file). They can be a useful way for you to organize 
and find your pictures because keywords are 
searchable. Albums are great for creating large 
groupings of pictures that you can readily access. 
With keywords and the search function in Organizer, 
you can go to specific images depending on the 
keywords you have used.

Keywords can be as detailed as you want. You can 
simply add words to large groups of pictures, which 
makes this process easier. Or if you want to be able 
to really find specific images, you can add a lot of 
very specific keywords to individual pictures.

Regardless of how you use keywords, they are still an 
important part of Photoshop Elements to understand 
and use as needed.

USE KEYWORDS
to tag your images
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Try This!
When all the task panel controls 
are open, your interface can get 
cluttered and confusing. Click the 
little arrows at the left of the panel 
category titles to open and close a 
category of control, such as 
Albums. Simplify the workspace by 
closing panel categories you are 
not using.

Important!
Pick keywords that help you find 
your photos. Your keywords will be 
unique to your type of 
photography. Adding keywords 
that others use but do not fit your 
images will make your searches 
confusing. Ask yourself, “What do I 
need to find?” in order to create 
keywords that work for you and 
your needs.

Customize It!
You can add as much or as little 
information as you want to 
keyword tags. The Create Keyword 
Tag dialog box includes the option 
to add notes or a specific address 
for a location. These are not 
requirements, only options that 
some photographers will use 
frequently, and others not at all. 
Use what you need and what 
works for you.
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 The Edit Keyword Tag Icon dialog 
box appears.

8 Click Import to look for 
something to use as an icon.

● The Import Image for Keyword 
Tag Icon dialog box appears.

9 Find a photo that looks 
interesting, perhaps from the 
same group of images.

0 Click Open to select this photo 
for your icon.

! Click OK to use this new icon for 
your keywords.

Note: It is not required to have an 
icon for every keyword tag.

@ Click OK again to accept the 
changes to the Create Keyword 
Tag dialog box.

 The Create Keyword 
Tag dialog box appears.

5 Choose a category.

6 Type a name for your 
keyword tag.

7 Choose an icon if 
desired by clicking the 
Edit Icon.
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● A small keyword tag icon appears 
below your photos.

% To put a keyword on specific 
photos, click the tag.

^ Drag the tag and drop it on the 
photo.

 When more than one keyword 
tag is added to a photo, the icon 
at the lower right of the image 
changes to a Yellow Tag icon.

● A new keyword tag appears in 
the category you chose in step 5.

# Select the photos that need this 
keyword.

 The selected photos have a blue 
frame around them.

$ Click and drag the selected 
photos onto the tag and they 
gain that tag.

 You can click and drag multiple 
times, with different groups of 
photos, to add more keyword 
tags to photos.

Keywords are one of those things that many 
photographers put off creating. The best time to add 
keywords is when you first import pictures into 
Photoshop Elements. At that time, you remember the 
most about your pictures. It is also easier to add 
keywords at this time because all your pictures are 
right in front of you.

It is important to understand that you can add 
keyword tags to one picture and only one picture, to 

a few, or to hundreds. Keywords enable you to be 
very specific, down to putting a specific name on 
something that appears only in one picture. They also 
enable you to be broader in your approach and put a 
single word across a whole group of pictures so that 
you can find that group again. Keywords work across 
all pictures within Organizer so that you can find 
pictures throughout Organizer by simply searching for 
keywords.

USE KEYWORDS
to tag your images
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Customize It!
Take any existing keyword tag and 
customize it for your needs. 
Right-click any keyword tag to get 
a context-sensitive menu. This 
enables you to edit your keyword 
or keyword category, add a new 
keyword to the category, add a 
new sub-category, or remove 
keywords or categories as needed.

Did You Know?
Photoshop Elements includes a 
special feature that enables you to 
find people in your photos for 
tagging. This is found in the 
Keyword Tags category of the task 
panel. You will see an icon with a 
person in a little photo ( ). Hover 
your cursor over it and you will see 
“Start people recognition.” Click it 
and all photos with faces are 
highlighted for you.

Try This!
You can type a list of keywords 
based on common descriptions of 
things in your photos. You can 
then import this list into Photoshop 
Elements by clicking the large 
green plus sign ( ) under 
Keyword Tags and selecting From 
File. This file must be an XML 
(Extensible Markup Language) file. 
You can save a Word file as an XML 
file for this purpose.

( To show specific items in an 
album, click the album before 
selecting Keyword Tags.

) To search for images throughout 
your image files, click Show All 
first.

q Type a name in the search box to 
show photos related to that 
name quickly.

& Find specific images 
based on your keyword 
by selecting the box in 
front of a specific 
keyword tag.

* Click additional tags 
to narrow your 
search.
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5 Click OK in the Analysis 
completed dialog box that 
appears.

6 Click the Face Recognition icon in 
the Keyword Tags panel.

1 Click an album to analyze for 
faces.

2 Select all images by pressing 
Ctrl/Cmd+A.

3 Click the Edit menu.

4 Select Run Auto Analyzer. 

 Photoshop Elements analyzes 
your group of photos for faces 
and other similarities. 

Keywords are a great tool to help you find specific 
subjects or types of photos. They do require you to 
set the keyword and find the appropriate photos for 
them. Many photographers like to identify people in 
their photos so they can find them later based on 
specific individuals in the images. 

With Photoshop Elements 8, you now can tell the 
program to “recognize” people in your photos for you. 
Face recognition can help you quickly go through 

photos to find specific instances of a person and add 
keywords for them. The program does a pretty good 
job of finding faces in everything, including portraits, 
group photos, and small people in larger scenes. You 
can even have Photoshop Elements highlight all the 
faces it can see as faces so you can give keywords for 
the individuals. 

FIND PHOTOS
with face recognition
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● If Photoshop Elements recognizes 
the person, it asks you to confirm 
if this is that person.

9 Click the green check mark if the 
name is correct.

 If Photoshop Elements does not 
recognize the person, it will ask 
again “Who is this?”

 Click the message and fill in the 
person’s name. 

0 Click Done when you have 
assigned all the names.

 The People Recognition 
window opens.

● A new person has a 
white square around 
her face with the 
message, “Who is this?”

7 Click “Who is this?” and 
type the person’s name.

8 Click the arrows at the 
left and right to move 
backward or forward in 
the group of photos. 

Did You Know?
Software companies have 
been trying to develop 
advanced face recognition for 
many years. There is a big 
demand for it in security 
markets. The ability to quickly 
scan security videos, for 
example, to watch for 
terrorists or other threatening 
travelers would be a huge 
benefit for security agencies. 

Try This!
Right-clicking a mouse is standard 
procedure for PC users. It is an efficient 
and quick way to access important 
contextual menus. However, for a long 
time, Apple did not use a right-click 
mouse, even though programs 
supported it. Today, all Mac users, 
whether they program an Apple 
mouse for right-click functionality or 
buy another brand, need to have and 
use a right-click mouse. 

Did You Know?
All the organizing tools shown in 
this chapter are simply that—tools. 
You have to supply the organization; 
Photoshop Elements does not. 
Organize your photos using Albums 
and Keyword Tags to mimic how 
you file anything. Following a 
plan that is true to your own 
organizational methods is more 
likely to create a system that will be 
versatile and efficient for you. 
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4 Change your thumbnail size with 
the thumbnail slider.

1 Click the Display button to 
change your display views.

2 Click Folder Location view to 
show a directory tree.

3 In the Folder Location view, you 
can click directly on a folder to 
find photos.

 If Photoshop Elements is not 
managing pictures in a folder, 
right-click the folder to add them.

Photoshop Elements has been designed for 
photographers and its interface reflects that. 
However, every photographer has unique needs and 
ways of working. You can change the way the 
interface for Organizer looks, and consequently acts, 
to customize it for your needs.

The controls that affect the look of the interface are 
buttons in the top menu bars, such as Thumbnail Size 
icons, and in the View and Window menus. Do not be 

afraid to try different looks for your interface — you 
can always change back to the original look by 
clicking the button or menu item a second time.

However you set up your interface, it should be 
something that helps you work more efficiently. Do 
not simply use something because it is available or 
someone else uses it. Be sure that it really helps your 
work in the program. Working in Photoshop Elements 
should be a fun way of interacting with your pictures.

CHANGE THE ORGANIZER
interface as needed
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7 Click Window to change what 
appears in the interface.

8 Click Hide Task Pane for a large 
image viewing area; click Show 
Task Pane for the normal view.

5 Click here to expand or 
collapse the panel 
section.

6 Click and drag along an 
interface edge to make 
it larger or smaller.

Did You Know?
You can control many features 
of Photoshop Elements with 
keyboard commands. These 
enable you to quickly access 
controls with just a couple of 
keystrokes. These keystrokes are 
listed next to the controls in the 
menus. For example, you can turn 
on and off the detail display for 
thumbnails by pressing Ctrl+D.

Try This!
The Timeline in Photoshop Elements 
can help you find photos by date. You 
can turn it on in the Window menu. It 
works for the entire database, so click 
the Show All button at the top left of 
the thumbnails first. Then select a 
specific time and photos appear below 
from that time. You can also drag the 
left and right sliders to limit the dates 
to show images.

Did You Know?
By default, all thumbnails 
have a small white border 
around them to make them 
show up better. Not 
everyone likes this border, 
but it can easily be turned 
off. Go to the View menu 
and click Show Borders 
around Thumbnails.



26

11

22

33

55
66

44
 The Preferences dialog box 

appears.

4 Adjust the User Interface 
Brightness and Grid Brightness to 
make the background lighter or 
darker.

5 Choose the order to show images 
by date (  changes to ).

6 Select a preferred Date Format 
(  changes to ).

● You can click any category to 
adjust specific preferences.

1 Click Edit to open the Edit menu.

2 Select Preferences.

3 Select General.

You can use Photoshop Elements right out of the box 
and get good results. However, the program has 
some preferences worth considering that enable you 
to fine-tune how it works with your computer and 
your needs.

Photoshop Elements has two sets of preferences, one 
for the Organizer and one for the Editor. In both 
cases, they appear at the bottom of the Edit menu. 
You can leave many of the choices at their default 

settings, but you might want to tweak some to refine 
how Photoshop Elements works for you. Many of the 
settings are self-explanatory. If you are not sure of 
something and want to try it, go ahead, because all 
the settings can be reset with the Restore Default 
Settings button at the bottom of the dialog box. Just 
reopen Preferences and use this button to go back to 
the defaults. This section offers some specific options 
that are especially worth looking at.

SET PREFERENCES
to make Organizer work for you
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Did You Know?
You can have images in a separate 
location not connected to your 
computer and still reference them 
in Organizer. Photoshop Elements 
keeps a small thumbnail for each 
of the images so that you can still 
see them in thumbnail view. You 
can change the size of these 
previews in the Files section of 
Preferences.

Try This!
Select photos by standard computer-
selection commands. Pressing Ctrl/
Cmd+A selects all photos currently 
displayed in the organizer. Pressing 
Ctrl/Cmd+clicking photos selects 
them one after another. Click one 
photo, and then Shift+click farther 
down; all photos in between are 
selected. You can also deselect a 
selected photo by Ctrl+clicking it.

Customize It!
If you use a lot of keywords, you 
can customize the way they are 
sorted in Preferences, in the 
Keyword Tags and Albums section. 
You can, for example, change how 
the keywords are sorted, either 
alphabetically or manually. You can 
also choose how the tag icons are 
used, and display or hide hints for 
face recognition.

0 Click Sharing to set up e-mail 
with Photoshop Elements.

! Choose your E-mail Client 
program.

@ Select Write E-mail captions to 
catalog to record and save 
captions (  changes to ).

# Click OK to close the Preferences 
dialog box.

7 Click Camera or Card 
Reader.

8 Click the Browse 
button to select a 
default location for 
your image files as 
they are copied from 
your camera or card 
reader.

9 Specify default settings 
for automatic 
downloading. The 
settings shown are a 
good starting point. 
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11 Back Up to an External Hard Drive

1 Click the Display button in the 
top menu bar.

2 Select Folder Location.

3 Find a folder you want to 
duplicate for backup in the 
folder tree.

 An external hard drive is one of 
the best ways to back up the 
images on your computer’s hard 
drive.

Whenever you read about fires and other disasters 
destroying people’s property, you always read about 
people wanting to save their photo albums. Photos 
are important to us in so many ways, whether they 
are memories of children growing up or artistic 
visions of a great natural setting.

Digital photos are vulnerable to loss from a hard drive 
failure — and hard drives do fail. Plus, without a hard 
copy, you have no other record of the images. By 
backing them up, you can add more security to your 

pictures than is possible with traditional film. It is 
very easy to back up your photos onto accessory hard 
drives that plug in to your computer. These have 
come down so much in price that many photographers 
back up their pictures on more than one.

Backup is so important that Adobe has added special 
backup features to Photoshop Elements 8, which will 
be covered in Task #94. You should have some 
backup system of your own that you can control and 
access easily, which is covered here.

BACK UP YOUR PICTURES
to protect them
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Use Backup Software

Note: You can obtain special 
backup software to help you with 
backing up your photos. 

1 With your backup software open, 
choose the folder or folders you 
want to back up.

2 Click the Folder icon to find your 
folder.

3 Choose the accessory drive for 
backup.

4 Click the Folder icon to select the 
location for backup.

5 Click Run Now to start the 
backup.

4 If necessary, reveal the 
external hard drive 
using the right slider.

5 Click the folder you 
want to duplicate.

6 Drag the folder to the 
external hard drive.

 The folder is saved on 
the external hard drive.

Did You Know?
Backup software can make 
your backups easier. Once you 
set up backup software for 
specific folders and a specific 
accessory drive, the software 
remembers those locations. 
The next time that you ask it to 
back up, it simply compares 
what is in those two locations 
and adds only what is new.

Try This!
Small portable hard drives designed 
for laptops are more expensive 
than other accessory hard drives. 
However, they can be handy for 
accessing your photographs from 
your laptop or other computer. In 
addition, you can easily store such 
a hard drive in a location separate 
from your main computer, giving 
you added protection.

Try This!
You can create a duplicate file structure 
on your backup drive as you can on 
your main computer. Simply create 
folders and levels of folders that are the 
same on both. For example, if your 
photos are structured by year and then 
by specific event, then use the same 
year and event structure. Then you can 
simply copy a folder from one drive to 
another in the same filing setup. 




